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This document outlines how to configure Medication Review functionality in Kroll and the
process of completing Medication Reviews for both paper based and electronic records.

Configuration

This section explains the configuration settings that must be in place before attempting to use
the Medication Review functionality.

Configuring Electronic Signatures

NOTE: Only complete this section if you are using Electronic Signature pads.

Before you can begin configuring electronic signatures, Allow Electronic Signatures must be
enabled in File > Configuration > Kroll > Configuration. This will require a support call and must
be completed before proceeding.

o Kroll Configuration Parameters |,E.|Lﬂ_hJ
General Qonfiguration| Modulesl IherapeuticAdvisorl gtationl Logging|

I Allow Electronic Signatures I Follow Provincial Legislative Rules for Fx Transfer
[C] Enable SetLaser labels
[T Allgw NDC

1. Go to File > Configuration > Store > General.

2. Place a checkmark next to Allow Electronic Signatures.

= P

=’ Store Level Configuration Parameters

General Palientl Drug I Doctorl Rx | FDB | Adiudicationl Labelsl Fleportsl Securit_l,ll Interfacesl Elrderl X-AFII Y-Ta Do| Ectrl E

Allovs User Calors [ Ahways Show Scan [ Diizplay window ‘When Services are Dawn
Allovs Column Configuration

Prompt to exit when clozing fill application Uze automatic capitalization

Enable MH / batch . )
e - Uze Unit Dose Packaging Allow Electionic Signatures |
Default language | Engiish J Default area code Enable Ctr-FrintS creen to Print Soreenshot
Defaut Cauntry Canada ﬂ Sort A% Transfer Stores By Store Mame j

Staore Information

3. Click OK to save the changes.
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Configuring Electronic Medication Reviews

1. Go to File > Configuration > Store > Rx > Counseling > Med Reviews/Dialogs.

w’ Store Level Configuration Parameters E =

| Generall F'atientl Drug I Doctorl Rz I FDB I .-’-‘«diudicationl Labelsl Heportsl Securityl Intelfacesl Drderl ><-AF|| Y- Ta Do| [ECtrl @

| e Generall 2- F'ricingl 3- Promplingl 4 - Mursing Homel 5 - Background Fx FiIIingI E- Workflowl i- CDUHSEHHQI a- EeFI:-:|

R Caunzeling Autarnatic Patient Counzeling
Allow editing counseling time On Mew R
Require Electronic Signature Ornly flag if patient hasn't had the drugin the last 180 daps
Uszers Permitted to Finalize Accepted Counseling [C] Or Refils
Fharmacist Licersed Technician [] On Drug Changes
Pharmacist Intern Pharmacy Tech Student Allows Uger bo Turn OFF Automatic Coungeling for an Bx
Fharmacy Student Pharmacy LAssiztant
IT Suppart
Yizible Tabs
Hardcopy Tab R Images Tab
RxTab “wiorkflow Tab
Financial Tab Packaging Tab

Med Reviews/Dialogs

Reguire Document Scan to Complete Paper Med Review
Enable Electronic Med Reviews

Fequire Electronic Signature

Allow Editing Caunzeling Time

T

2. Inthe Med Reviews/Dialogs area above, ensure the following options are set appropriately.

o Require Document Scan to Complete Paper Med Review: this option allows you to
complete paper-based Medication Review using the document scan functionality;

e Enable Electronic Med Reviews: enabling this option allows you to use the electronic
version of Medication Review;

e Require Electronic Signature: enabling this option prompts for electronic signatures
where necessary (only if you are using Electronic Signature pads).

e Allow Editing Counseling Time: this option allows you to modify the system-calculated
amount of time it took to complete the counseling session.

3. Click OK.
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NOTE: If you turn off the Require Electronic Signature option and keep the other options
enabled you will still be able to complete the reviews on-screen. However, you will need to
print the report, in order to capture pen-to-paper signatures and then scan it back into the
system before giving it to the patient.

Electronic Medication Reviews

This section explains how to perform an Electronic Medication Review. Ensure your system is
configured for Electronic Medication Reviews before proceeding. See Paper Medication Review
for information on the non-electronic process.

NOTE: The automatic prompts will not appear if the patient does not meet the criteria for a
Medication Review. However, based on other available information and your professional
judgement, you can determine whether the patient might benefit from a Medication Review
and then manually create a Medication Review.

Configuring the Medication Review Prompt

The system prompts for Medication Review when the option Prompt for Medication Review is
enabled under File > Configuration > Store > Rx > Prompting.

[ w’ Store Level Configuration Parameters |E| Ljﬁ ]
| ﬁenerall Eatientl Drug | Dgct0l| Bx | ECE | gdiudicationl Labelsl Heporﬁsl Eecurit_l,.ll lnterfacesl Drdgll K-AHI ¥ -To Do| [Ectrl E

1- Generall 2-Pricing] 3~ PleDlinQ| 4 - Nursing Homel 5 -Backgmound Rx FiIIingI B- Workflowl i- Eounselingl 8- Eth-c|
Diug Prograrns

Prampt ta use Drug Subs 7] Automaticaly use Dirug Subs [] Participate in the Rx Canada / Health Inform Program

Usze Dirug Subs when B atching

Prompt If Doctor Refuged Repeat 'When Cancelling Rix [ Participate in the Pharmacy Access proaram

Prompt for Comments when Canceling an Fix [ Use Station Mame Subdirectaries For Pharmacy Access
[ Ahways require comment Days Back: 365

[ Prompt for Comments when Inactivating an R [] Enable Rx Canada Frogram [RxGateway)

[T Always require comment

[ Prompt for Patient Counzelling on new R . . . . .
7] Prompt to Bateh NH Fies [] Prompt ta Enral Patients in Refil Feminder or Auta Refil Program
F ) ) ) ) Prompt to Enrol MH Patients in Refil Reminder or &uto Refil Program
Erompl ;\lheFr; not d'SE:ES'n%aS cllrug 5 PF‘?CR Size Prompt to Enable Rxs for Refill Reminder and Auta Refill Program
rompt For Fiepeats er_1 CRing an Fix § Enrol Patients for Pickup Motification Mo j
Prompt Ta Use Manual Price From Last Refill

Services

[7] Remove Manual Price for Batched Fixs Enrol MH Patierts for Fickup Notification No j

[] Prompt if Doctor Autharization Received for Narcatic Rxs

[] Check far High Intensity Drugs Prompt to copy workflow packaged info for cancel and refill Rxs
Prompt if there iz not enough inventany to fill the Ax Prampt to copy to nevs number if refiling an A= with no repeats

[] Prevent Copying an Inactive Rx to a Mew Mumber [ Prompt for Due Date on autofill batches

[] Show local patient profile on fill [ Prompt for T« comment on autofill batches

Frompt ta Copy "Mistake" Rixs to a New Number Save Routs cods from Rk a5 defaul valus if no defaul is set Ask |

[T Shaw thermal/dat matriz label config an autafil
Save Form eode from R ax default value if no default iz set Ak j
[ Prompt to Print Script Image for 1st Fill of an Unfiled R«
[ Prompt for &4DL Plan Information if Sé number is NOT set I Prompt for Medication Review I

] Track Medication Review Rejection Reazon:
Allows Mever Prompt’ For Medication Review

[] Prompt if waz Undeliverable when Canceling an Rix

Search " OK
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When the option ‘Prompt for Medication Review’ is enabled, the system screens each patient
for Medication Review eligibility every time an Rx is processed. If the patient is eligible, the user
is prompted and presented with a number of options as shown below.

%’ Select an Option E S

This patient may be eligible for the MedReview Standard (MR-5) program.

[ Add to Med Review Queue ]
[ Do not prompt me until the next time the patient comes in. ]

[ Do not prompt until ... ]

| Undecided |

e Add to Med Review Queue: Selecting this option adds the Med Review record to the
Medication Reviews queue which can be accessed from the Patient record or
F9 — Workflow. See section ‘Completing Medication Reviews ‘Saved for Later’ for
further details.

e Do not prompt me until the next time the patient comes in: This will suppress
prompting for today. The next time the patient comes in to fill an Rx, you will be
prompted for the Medication Review.

e Do not prompt until: This will allow you to dismiss the prompt for a specified number of
days, or until a specified date, after which the prompt will appear.

o Never prompt for this patient: This will suppress any further prompts for this patient.
This option is only available if the configuration option of Allow ‘Never Prompt’ for
Medication Review is enabled.

e Undecided: The prompt will re-appear once again the next time a prescription is filled
for the patient.
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Creating an Electronic Medication Review (Manual)
1. Bring up the patient card using the F3 Patient search.

2. Select Medication Review/Dialogs from the right navigation pane.

File Edit Patient Profile Reports Utilities MNH Central Fill Cards Session Help
F3 - Patient F5 - Drug F7 - Doctor I F9 - Workflow F11 - Drop-off " F12 - New Rx “ Alt-X - Start ]
Last Name Doe First Name Jane salutation Ms. j _ Save Patient
Profil
Address1 100 Main St Phone Numbers (1) (PS8 girthdate 01/01/1980 —
Description |Phone | All Rxs
Address 2 Age 34 years -
J J Cell (555) 555-5555 J Active Rus
City Vancouver | Prov BC - Gender Female - il il
No image available Active Rxs w/Passtimes
Postal M2M 2 Country Canada j language English j Refillable R
Hiakle 5
Email janedoe@email.com Family Doctor Liont Pricing Profil
rncing Frofile
Quick Code [¥eIght (Ltoas ] Detete ] Mot Disp./OTC Rxs
J
Comments (0) ODB hd - i
Topic |Comment J Rus Filled in Error
Plans (1) (F2) Cos] (£el) Suspended Rxs
| subPlan Code| Group ID | client ID |Expiy | -
1 RCMP 33040 33223 Perform FDB Analysis
View
Alternate Addresses
i = . Batches
Allergies (0) [F2] (Tng] (Del] ngeral] Family Nursing Home} Copaygl Commgmcatlons] Other ] [ (=
Charting
Krol\ Mursing Home j Admit Date Tnactive [ c .
ONSEN’
Ward j Discharge Date Credit Card
redit Cards
Cycle <Default> | Last TR Date - -
oCuUments
_ _ Bed Status
Medical Conditions (0) Ing Roam € u Medication Review/Dialogs (15) I
Diet Rx Counseling History

3. The Medication Review profile will appear. Click N — New Review/Dialog.

w# Patient - Helvey, Ricky

U EB|o = =K

File Edit Patient Profile Reports

Utilities MNH  Central Fill Cards Session  Help
F3 - Patient F5 - Drug F7 - Doctor F3 - Workflow F10 - Pickup “ F11 - Drop-off ” F12 - New Rx " Alt-X - Start
Last Name Helvey First Name Ricky Salutation j _ Save Patient
i
N - New Review/Dialog All Res
Medication Reviews (0] Active Ruxs
Type Status Fee Status Created ¥ | Completed a || Active Rxs w/Passtimes

Refillable Rxs
Pricing Profile

4. The Medication Review/Dialog screen will appear. Select a review type from the dropdown
menu and click Perform Now. If you wish to add to the Med Review queue in order to
complete the Medication Review later, click Save for Later.

(& ] ]
El

o Medication Review/Dialog

Type MedReview Standard (MR-5)

EPerformu&I lga\reforlaterl l X cancel l
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5. The Medication Review Rx Selection screen will appear. Rxs under the Pre-Selected tab are
selected by default; Rxs on the other tabs are not. Proceed through each tab and check the

Rxs you want included in the report.

your pharmacy only.

filled at you pharmacy and at other pharmacies.

Select Do Not Profile Rxs if you want the report to include Rxs that have been filled at

Select Profile Other Store Rxs (TRS) if you want the report to include Rxs that have been

Use the Include last [x] month(s) of Pharmanet Rxs to specify a date range.

S IR=nE T x|

¥ Medication Review Rx Selection

Pre-Selected (2) | Other Rxs | Unfills | Not Dispensed | Discontinued|
Ry Num Drug Fill Date
1000002 Xanax 1mg 06-Aug-2014
1000001 Paxil 10mg 06-Aug-2014
Select All ‘ I Select None ‘
Pharmanet Medications
@ Do Mot Profile Rxs
_! Profile Other Store Rxs (TRS) I Include last 1 % manth(s) of Pharmanet Rxsl

Drug lines to use in review

j Drug line 2 Default

&

Drug line 1 Default

" 0K

If you have electronic signatures enabled, the Pharmanet Medications section will have

an option called Profile All Rxs (TPR). Select this option if you want to include all Rxs for

the patient available on the Pharmanet network i
your pharmacy may appear twice on the report if

n the report. Note that Rxs filled at
this option is selected.

Pharmanet Medications
@ Do Mot Profile Rxs

L Profile All Rxs (TRP) |
_) Profile Other Store Rxs (TRS)

Include last 1 % maonth(s) of Pharmanet Rxs

Drug lines to use in review

j Drug line 2 Default

E

Drug line 1 Default

' OK
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When you are finished, click OK.

6. The (MR-S) - Standard screen will appear. Click Next to proceed through the tabs,
completing the required fields as you go.

NOTE: The type of review that is displayed on screen depends on what type of review was
selected in Step 4. In this example, the (MR-S) - Standard screen appears.

Questions

The Questions tab includes a list of questions that the pharmacist is to ask the patient to better
understand their situation. Answers are recorded by selecting the appropriate option from each
dropdown menu.

Questions I Medical History | MNon-Prescription Medications | General Comments | Pharmacist Comments|

Has a doctor requested a medication review <Not Answered= j

Doctor Med Review Reason - Has multiple diseases No j

Doctor Med Review Reason - Has one or more chronic diseases No j

Doctor Med Review Reason - Has a medication regiment including one of more non prescription medications <Mot Answered= j
Doctor Med Review Reason - Has a medication regiment including one of more natural health products <MNot Answered= j
Doctor Med Review Reason - Has a drug therapy problem m j

Doctor Med Review Reason - Has been recently discharged from hospital <Mot Answered= j

Doctor Med Review Reason - Has multiple prescribers <Not Answered> j

Doctor Med Review Reason - Takes medication(s) that require laboratory monitoring <Mot Answered> j
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Medical History

The Medical History tab displays the medications that have been selected on the Medication
Review Rx Selection screen.

| Questionsl Medical History I Non-Prescription Medications | General Commentsl Pharmacist Comments
Patient Medical History

20 TAB Tylenol With C?delne No.... Gy TEE j
White Round Tab McNeil 3

Dr. Zandy, Utah Therapy Problem | BN #N R B vI

Last Fill Date: 24-Feb-2014, Days Supp
Source: This Store

TAKE 1 TABLET TWICE A DAY AS Comments
MNEEDED

Indications

Action

For each medication listed:

¢ Note if the patient is currently taking the specified medications and select Yes/No from
the dropdown list.

e Enter the reason for using the medication based on the patient’s feedback in the
Indications field.

e Enter any general comments in the Comments field.

Use the Del button to delete a record from the Medical History tab.
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If you indicated that one ore more of the patient’s medications has a drug therapy problem on
the Questions tab, a Drug Therapy Problem Details section will appear for each identified
medication(s) and a consultation sheet will print for each. Complete the necessary Drug
Therapy Problem Details fields before proceeding to the next tab.

Questions | Medical History |Non—Prescription Medications | General Comments | Pharmacist Comments|

Patient Medical History

20 TAB Tylenol With C(_)delne No.... Currently Taking j
White Round Tab McNeil 3
Dr. Zandy, Utah Therapy Problem j

Last Fill Date: 24-Feb-2014, Days Supp
Source: This Store —
TAKE 1 TABLET TWICE A DAY AS Comments
MNEEDED

ns

Drug Therapy Problem Plan

Drug Therapy Problem Details

Theraov Plan
Therapy Plan

Action By Pharmacist
["| Adapt Prescription ["| change/start/Stop (non-Rx) || Refer to Medical Physician

["] Give Immunization (public) [ | Eliminate Patient Barrier [ | Refer to Other Health Professional

["] Give Immunization (private) || provide Education "] other:

Note that if you enter a Therapy Problem, the Medication Review type will change to
MedReview Standard (MR-S + MR-PC).

P - Print/Reprint
F2 - View Details
Medication Reviews [1]

Type

|MedReview Standard (MR-S = MR-PC) | Completed Electronic Pending Claim 22/08/2014 22/08/2014

|Status Fee Status Created ¥ |E0mpleted | -
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Non-Prescription Medications

The Non-Prescription Medications tab provides space to record any OTC/non-prescription
medications the patient is taking.

Click Ins to add a non-prescription medication to the tab.

| Questions | Medical Histor_vl Non-Prescription Medications I General Comments | Pharmacist Comments

Non-Prescription Medications / Herbals / Supplements
Currently Taking  Claritin 10 mg For season allergies
Yes j

X save for Later

e Note if the patient is currently taking any OTC medications and select Yes/No from the

dropdown list.
e Enter the name of the medication in the medication field.

e Enter any appropriate comments in the comments field.

Use Del buttons to remove any OTC items.

10
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General Comments
The General Comments tab provides space to record any comments you want included on the

report printout.

| Questions | Medical History | Non-Prescription Medications | General Comments | pharmacist ¢

O Next

Pharmacist Comments

The Pharmacist Comments tab provides space to record any comments that the pharmacist
wishes to enter concerning the medication or patient in the free form.

| Questions | MedcaﬂHls(oryl MNon-Prescription Medications | GeneraﬂConI'llerltsI Pharmacist Comments |

[ ]

7. When you are finished click Finalize Review.

11
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8. The Medication Review prompt will appear. If you have Allow Editing Counseling Time
enabled, enter the amount of time it took to complete the review in the Time spent field.

The Assessment Location information is pre-populated with the pharmacy information. If
the Medication Review was physically conducted in another location (LTC facility, patient’s
home) other than the pharmacy, enter the name of the location and the address. Complete
the Other Professional Involved fields if another health professional assisted with the
review.

When you are finished, click OK.

«f Medication Review E =

Time spent: 00:30 On 14/07/2014 By Pharmacist (F) j

Assessment Location

MName Kroll Pharmacy
Address 220 Duncan Mill Road, Suite 201, Toronto, ON M3EB 3J5

Cther Professional Involved

MName T
Title Technician

Phone

I W OK I l X cancel l

Affixing an Electronic Signature

NOTE: If you do not have an electronic signature configured, print the Medication Review
Report, have both the patient and the pharmacist sign the report, and scan it back into the
system.

9. Have the patient sign his or her name on the electronic signature tablet. Click the OK button
on the signature tablet.

12
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The patient signature appears once the patient signs on the electronic signature tablet.

10. Have the pharmacist sign the electronic signature tablet.

N

11. When you are finished, tap Done on the signature tablet.

Printing a Medication Review

12. A prompt will appear asking if you want to print a paper copy of the electronic Medication
Review. Click Yes.

13. The Medication Review report print form will appear. Select the appropriate print options
and select the appropriate user from the Prepared by field. Click Print and provide this copy
to the patient.

13
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¥ Medication Review Report (MedReview Standard (MR-5), 2014—Aua—22] . L’ = JL =y éj
File
Options
Print store logo
9

Print Last Fill Date
Prepared by
2 % Extra Lines far Allergies and Conditions
2 % Extra Lines for "Medications | Take"

Il ¢ % Extra Lines for "Current Medications” I
2 % Extra Lines for "Clinically Felevant Medications the Patientis no longer taking”

. |
Printer j Copies 1
Tray  Automatically Select j Collate [ Duplex ||

E ’Restore Defaults] [ " Erint ] ’ Presgiew ] ’ X Close] IJ

Billing a Medication Review

14. Once printing is complete, the Fee For Service claim will automatically populate in the F12
screen. If necessary, perform a doctor search to locate the pharmacist to use as the
prescriber and ensure all of the other information entered on the F12 screen is correct.

NOTE: If the user account of the pharmacist logged into the terminal during the processing
of the Medication Review includes a license number that is identical to the license number of
a Prescriber card in the Doctor file, then the Prescriber field on the F12 screen for the claim
will be populated with that prescriber.

14
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15. Click F12 - Fill Rx. The claim will be transmitted to the appropriate party for payment.

Eile Edit Bx View Labels Profile Reports Utilities NH Central Fill Cards Session Help
F3 - Patient “ F5 - Drug H F7 - Doctor F9 - Workflow F11 - Drop-off I F12 - Fill Rx I Alt-X - Start
= = First Fill Last Fill Information ; :

0 NewRx Pending Adj 10814 || 0 0 Oty $0.00 Init | o Lookup H X CanceIJ
Priority Default Wait Time ﬂ@ Due in 19 mins Forward Rx  [F2] Work Order 0 [Fz] Delivery Pickup -
Patient Search Drug Search Pack J Doc Search Loc J
Mame | Doe, Jane Age34  |Brand | MEDREVIEW STANDARD(M MName | Pharmacist, Test
Address | 100 Main 5t Female | | Generic Address
City Vancouver Frov |BC Pack Form Sched City Prov
Fhone | Cell (555) 555-5555 Purch OnHand |0 Noimage || Phone
Plan RCMP Client IO |22222 DIN Min Qty 0 Lic® Alt, Lic®
Allergies Sig MEDREVIEW STANDARD (MR-S) Tnit KRL |KRL AuthQty 1 1

MEDREVIEW STANDARD (MR-5) Disp Qty 1 Refills(+) Rem Oty 1 1
G.P. % 0
Days 1
Acq Cost
Conditions ProdSel None v Cost 50.00
oute of Adm B S 2 Morkap 5000
oute of Admin Labels 1 lEJ ee i
Pe=gzimm = Total $0.00

Medication Review Options

Several Medication Review options are available from the right navigation pane on the (MR-S) -
Standard screen.

Asthma, unspecified, with stated status asthmaticus

Questions | Medical History | Mon-Prescription Medications | General Comments | Pharmacist Comments

File Edit MedReview View Profile Utilities MNH Cards Session Help
F3 - Patient F5 - Drug F7 - Doctor Fa - Workflow F11 - Drop-off F12 - New Rx Alt-X - Start
. , Review
(MR-S) - Standard Reviewed With | Dukes, George (In Person) F2
Print Medication Review
Patient | Dukes, George Address | 1926 Albert Street Select Bxs for review
Birth | 01/04/1908 | 106 years Male Plan ClientID Phene | Home (403) 762-1212 View Follow Ups
Allergies Conditions View

Patient Charting
Patient Documents

Patient Med Reviews (13)

Has a doctor requested a medication review <Not Answered> j

Doctor Med Review Reason - Has multiple diseases <MNot Answered> j
Doctor Med Review Reason - Has one or more chronic diseases <Not Answered j

Doctor Med Review Reason - Has a medication regiment including one of more non prescription medications <MNot Answered» j

Profile
All Rxs

Active Rxs

Active Rxs w/Passtimes
Pricing Profile

Mot Disp/OTC Profile

15
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Review

Print Medication Review
When this option is selected, the Medication Review report screen will appear, allowing you to

set various print options. Configure the appropriate print options. Select Preview to view the
report or Close to exit.

————
o Medication Review Report ((MR-S) - Standard, 2014-Aug-22) = e e
File Version 10

Options

|1 Print store lago
[ Print Last Fill Date

Print Pharmacist comment

Printer Microsoft XPS Document Writer j Copies 1
Tray  (Default tray) j Collate  [] Duplex
Festore Defaults] [ " Erint ] [ Prewiew ] [ X Closze ]

16
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Select Rxs for review

If you wish to add/edit Rxs on the Medical History tab, click the button Select Rxs for review.
When selected, the Medication Review Rx Selection screen will appear, allowing you to add
and remove items from the Medical History tab on the Medication Review Annual Review
screen. Click OK to save any changes and Cancel to close the screen.

o Medication Review Rx Selection RS E=na=n T x|

Pre-Selected (2) | Other Rxs | Unfills | Mot Dispensed Discontinued|
Rxt Num Drug Fill Date
1000002 Xanax 1mg 06-Aug-2014
1000001 Paxil 10mg 06-Aug-2014
Select All ] ’ Select None

Pharmanet Medications

@ Do Not Profile Rxs
_! Profile Other Store Rxs (TRS) Include last 1 % maonth(s) of Pharmanet Rxs

Drug lines to use in review

Drug line 1 Default j Drug line 2 Default j

7ok

View Follow Ups

When this option is selected, the Medication Review Follow-ups screen will appear, allowing
you to create follow-up reviews for the patient.

NOTE: This is something that you initiate to follow up with the patient after the Medication
Review has been completed. This is NOT a Medication Review Followup review.

o Medication Review Follow-ups l oo B Jl =NRN X
Medication Review Print Report
Type  (MR-S) - Standard Completed On
Patient Doe, Jane Completed By

Follow-ups (0) [FZ] (Tns| [Del]
Due Date  |FReason Brand Mame FoxNum |Resolved | o

17
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To add a follow-up, click Ins and complete the Medication Review Follow-up screen. When you
are finished, click Save.

¥ Medication Review Follow-Up (0B foo o B [
Medication Review
Type  (MR-S) - Standard Completed On
Patient Doe, Jane Completed By

©) Do nat follow up
@ Follow up required in 17 days = 08/09/2014

LE=HllFollow Up Patient - Confirm understanding of Med Review form j

Comment
[[IResalved on by
Comment
[ ' Save ] ’ XCanceI]
View

Patient Charting

When this option is selected, the Patient Charting form will appear, displaying information
about the patient’s weight, height, blood pressure, blood sugar, and so on.

«* Patient Charting Bllo =
Weight | Height | Blood Pressure | Blood Sugar | Cholesterol | Creatinine CL [ INR [ Clozaril Han (3
* Weight Values [3) (FZ) (Ins) (Del)
=2 : : i ' J Date ‘Weight -
2t — T T
220 H \ H i i y o 1040172012 60

210 AR B i 1 Lol D oe/j2011 58
200 : : : . : !

190
180

170

0 T
OlJantl OMarfl 0agll Ol OtSepll OfNovil Ollanl2 02 0IMagl2 OlUNZ  01Sepl2 OlhoviZ Ollani3

X Conce
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Use the F2, Ins, and Del buttons to modify, insert, or delete information on this screen. Click
Print to print or Cancel to close the screen.

Patient Documents

When this option is selected, the Patient Document List will appear displaying a list of
documents associated with the patient.

=] pg

Patient Document List

B Sk [AddﬂewDocument ¥ |

Documents (1)

Title Init  |Document Type|Created ¥ |Retain Until |*
MedReview Standard (MR-5) P Med Review  |11/07/2014

Use the F2, Ins, and Del buttons to modify, insert, or delete a patient document. Click Close to
exit the screen.

Patient Medication Reviews

When this option is selected the Patient Medication Reviews and Dialogs screen will appear,
displaying a history of all reviews for the patient including any that are currently in the
Medication Review queue.

s

o Patient Medication Reviews and Dialogs

P - Print/Reprint
F2 - View Details

Medication Reviews (14)
Type Statug Fee Status Created ¥ |Completed -
[MR-5} - Standard Pending Review Mot Completed Yet 22/08/2014 T
[MR-5} - Standard Completed Electronic Pending Claim 22/08/2014 22/08/2014 ‘ ‘

Double-click a Medication Review to view its details. Click Close to exit the screen.

Profile

The Profile menu on the Medication Review Annual Review screen is identical to the Profile
menu on the patient profile. This menu allows you to view All Rxs, Active Rxs, Active Rxs w/
Passtimes, Pricing Profile, and Not Disp/OTC Profile.
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Completing Medication Review ‘Saved for Later’

1. To call up Medication Reviews ‘Saved for Later’ or added to the Med Review Queue via
auto prompting, do one of the following:

Patient Card

a) Bring up the patient card using the F3 Patient search and select Medication
Review/Dialogs from the right navigation pane.

b) The Medication Reviews queue appears with all the Med Review records that are pending

review.
File Edit Patient Profile Reports Utilities MH Cards Session Help
F3 - Patient F5 - Drug F7 - Doctor I F2 - Workflow " F11 - Drop-off " F12 - New Rx “ Alt-X - Start ]

Last Name Dukes First Name George Salutation j QK save Eatient
Profile

N - New Review/Dialog P - Print/Reprint All B

F2 - View Details D - Pharmacist Declined R - Patient Refused Active R

Medication Reviews [14] chve s

Type |Status | Fee Status Created ¥ |Completed | & | Active Rxs w/Passtimes

[MR-5] - Standard Pending Review Mot Completed Yet 22/08/2014 Refillable Rxs

[MR-5] - standard Completed Electronic Pending Claim 22/08/2014 | 22/08/2014

c) Select the Medication Review record you want to complete and click F - Call Up.
F9 - Workflow

a) Select F9 - Workflow from the Alt-X Start screen and select Medication Reviews from the
right navigation pane.

b) The Medication Review queue will appear. Select the Medication Review you want to
complete and click F - Call Up.

File Edit Utilities NH Workflow Cards Session Help

l F3 - Patient F5 - Drug | F7 - Doctor ‘ F11 - Drop-off

R - Patient Refused

Alt-X - Start
£ Refresh |

space - Mark Rxs

P - Print/Reprint
D - Pharmacist Declined

Workflow Actions
Rx's To Do

Medication Reviews

Patient | Type

Dukes, George
Dukes, George
Dukes, George
Dukes, George

MedReview Standard (MR-5)
MedReview Standard (MR-5}
MedReview Standard [MR-5)
MedReview Standard (MR-5}

Completed Electronic
Pending

Printed Paper
Completed Electronic

Pending Claim

| status | Fee Status |Created  |Completed| » | Rx'sInProgress
Dukes, George M:dR:v!:wStandard {MR-S) Pendl.ng Review Not Completed Yet 15/05/2014 Pending Adjudication (0)
Dukes, George MedReview Standard (MR-5) Pending Review Mot Completed Yet | 07/05/2014
Dukes, Gearge MedReview Standard (MR-S] Completed Electronic  Pending Claim 07/08/2014 07/08/2014 Trouble (0)

07/08/2014 07/08/2014

Review Mot Completed Yet 07,/08/2014
Review Mot Completed Yet 06/08/2014

Pending Claim

06,/08/2014 06/08/2014

Rx Counseling (2)
Medication Reviews (9)

2. Complete steps 3-8 of the Creating an Electronic Medication Review section.
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Sample Electronic Medication Review Report

(MR-S) - Standard
Kroll Compauter Systems Pharmacy, Suite 201- 1502 West S0th Avenue South Vancouver Mainland, Vancouwer BC VOV 0W0
Phone: (555) 555-5555 Fax: (666) 666-6666

BEST POSSIBLE MEDICATION HISTORY (BPMH) - Patient Section

PATIENT
FlrstName LastName Family PhysicianName
Jane Doe Doctor, Test
008 Gender | PHN Family PhysicianPhone Family PhysicianFax
19-Jul-1957 F 123456789 mp1nam
Affergies Condibions
AllergyCream N/A

[[] Patient is nottaking any non-prescription or natural health products atthis time.

MEDICATIONS 1 TAKE - Frescription, non-prescription, natural health products -

WHAT | TAKE WHY | TAKE IT HOW | TAKE IT SPECIAL INSTRUCTIONS
Mame strength & form of medication Disaasa condifion ar For exampla when Io fake & ¥ applicabla)
as noled on the prescription ar symploms | addressas fake withiwithou! bod
medication packspe labal wamings el
1 | CAP Teva-Amoxicilin 500rmg AS DIRECTED
2 | TAB222375/8mg AS DIRECTED

ErF'atient is nottaking any non-prescription ornatural health products atthis time.

PATIENT ACKNOWLEDGEMENT

My pharmacist has explained to me the purpose of a medication review service. Iagreed that I could benefit fromthis publicly funded
service. The review was conducted in a place that respected rmy privacy. During the appointment my pharmacist fully explained any
medication changes or concerns to me. Atthe end of the medication review appointment, my pharmacist gave me a list of my current
medications. The list includesany changesresulting fromthe medication review service provided.

22-Aug-2014

Date Prepared Patient (or Representative) Signature Crystal(063583)

e This printout only includes Rx items that were marked as Currently Taking in the (MR-S)

- Standard screen.

e Provide this printout to the patient.
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(MR-S) - Standard
Kroll Computer Systems Pharmiacy, Suite 201-1502 West Sith Avenue South Vancouver Mainland, Vancouwer BC WV 0W0
Phone: (555) 555-5555 Fax: (666) 666-6666
BEST POSSIBLE MEDICATION HISTORY (BPMH) - Health Care Professionals Section
CLINICAL NEED FOR SERVICE
Has a prescriber requested a medication review: |:| No I:‘ res, Prescriber:
Patient.
I:l Hesmultiplediseases l:l Hasbeenrecentlydischargedfromhospital
l:‘ Hss cneormaore chronicdiseases D Takesmedication|{sthatequirdaboratorymonitoring
D Hasadrugtherapyproblem D Hasamedicationregimentincudingenesimeorenaturalhealthproducts
I:‘ Hesmultipleprescribers D Hassmedicaticnregimentincludingonecfmorenonpresoipticnmedications
CURRENT MEDICATIONS
HAME OF DRUG PRESCRIBER NAME & | VERIFIED ACTION HOTES
& STRENGTH PROFESSION Cantinue 25 per 1 = FHARMANET | For axampie: fanglizabis)
For axammie 072 = FATIENT Drug Thempy. Frobiem plan .
BRFEICiERAD REN et e Framakisy rfamal Saligw up mequimd
natumpsth, phamsclist natient or 3 = FATIENT fnat n Fharmabiet
1 |CAP Teva-Amoxicillin Dr. Smith, John H 2 - Palenl DrugTherapyProblem
500ma DoctofPhysician) (@fferenl Than Prarmatis) Plan
2 |TAB 222 375/8mg Dr.Smith, John H 2 - Patimrit
DoctofPhysician) [iffmrent than Pharmabist)
CLINICALLY RELEVANT MEDICATIONS THE PATIENT 15 NO LONGER TAKING
NAME & STRENGTH VIHY IT WAS TAKEN MOST RECENT WHO STOPPED IT COMMENTS
OF DRUG REGIMEN Hame of prescriber, phamacist Reasanir siopping, effechieness
patient or Diher other reisvant intmation
LOCATION OF THE ASSESSMENT
Nzme Addresz
KrollComputerSystemsPharmacy Suite 201-1502 West 50th Avenuz
attention Sources of Infarmation I Wls cocument Include [t are ot limiked i) Prammaiiet, local prammacy data and T patlent. The patkent ks responsile
Heaith Care 0l M2 Eccuracy a0 COMpIEENess Of Me OEE Mey pIoviced When TS OOCUTENT WSS DegEred and TOr SVENg Me pREMTECH! of &y ENge 0
Professionals: ?ﬁxﬁt—zébsg;e prammecls fs responsible ’bl Information In Tils document Bat changed as a resuR of providing a medication review
Fege 2of 2 Freparecn: 22-Aug-2014 Freperedby: Crystal(06363)

The CURRENT MEDICATIONS section of this report includes Rx items that were marked
as Currently Taking in the (MR-S) - Standard screen.

The CLINICALLY RELEVANT MEDICATIONS THE PATIENT IS NO LONGER TAKING section
includes Rxs items that were not marked as Currently Taking in the (MR-S) - Standard
screen.

This printout is for pharmacy use only and should not be provided to the patient.
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(MR-PC) - Pharmacist Consultation
Kroll Computer Systems Pharmacy, Suite 201- 1502 West S0th Averwe South Vancouwver Mainland, Vancouwer BC VW 0VD

Phone: (555) 555-5555

PATIENT and PHYSICIAN INFORMATION

Fax: (666) 666-6666

Smith, JohnH

Firzt Name LaztName
Jane Doe
FAN DafecfEinh
123456789 19-Jul-1957
FamiFhyzicianiame FamilF Fysiciane honeumber

(111)111-1111

DRUG THERAPY PROBLEM

UnnecessaryDrug

MEDICATION INVOLVED (drug name, route, dose, frequency, duration)

CAPTeva-Amoxicillin 500mg
ADIRECTED

PLAM (whatis the issue whatwill be donetoresolve the problem, by whom andwhen)

ACTION BY PHARMACIST (select all that apply)

|:| Initiafdenitoring

Mﬂdappresaipti:}n

I:‘ Givemmunizatiodpublic)

I:‘ Givdmmunizaticprivate)

D Change/Start'Stofon-Fx)

ContactPresoriberteChange/Start/Stop{Rx)

[] ReferttomtedicalPhysician

I:‘ RefertaCtherHeslthProfessional

I:‘ ProvidEducation

I:‘ EliminatéFatienBarrier

l:‘ Othdtecommendation

MOTIFICATION, if applicable (notification dates, persons notified)

22-Aug-2014
Freparedon
attantion Sources of Infrmation In Miks aosument I'r,l_ne [ are mot TimRed bo)
Heaitn Cars I e 300UTECY 300 COMPERNESE OF TE
Frofessionals:
sENE 1 Me pEent
Page 2 of 2 Freparedn: 22-Aug-2014

Crystalj08383)

Prammaiet, local phamacy data and e peflent. The patient ks responsiole
WOER TS COCUMENt WES DregpEned and TOr avENg Me DREMEcET of & CENgE 0
ese medications. The phamiack: Is responsile ’br Information In s document Bt changed 2= a resull of providing 3 medication review

Freparedby: Crystal(06363)

A (MR-PC) - Pharmacist Consultation sheet will be printed for each medication with an
identified Therapy Problem on the (MR-S) - Standard screen.

This printout is for pharmacy use only and should not be provided to the patient.
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Viewing a Completed Medication Review

With Electronic Signatures Enabled

1. Bring up the patient card using the F3 Patient search.
2. Select Medication Review/Dialogues from the right navigation pane.

3. Highlight the completed Medication Review and click F2 - View Details.

File Edit Patient Profile Reports Utilities Central Fill Cards Session Help

F3 - Patient FS - Drug F7 - Doctor F9 - Workflow F11 - Drop-off ]Z F12 - New Rx Alt-X - Start ‘
Last Name  Test First Name Pat Salutation LJ oK we | X cancel

N - New Review/Dialog P - Print/Reprint F - Claim Fee
F2 - View Details D - Pharmacist Declined R - Pati R

Medication Reviews (7)

[(F2) [Ing)[Dal)

Type | Status | Fee Status |Created ¥ | Completed | -
MedReview Standard [MR-5) Pending Review Not Completed Yet 30/07/2014

MedReview Standard [MR-5) Refused by Patient Mo Fee Applicable 30/07/2014 30,07/2014

MedReview Standard [MR-5) Declined by Pharmacist Mo Fee Applicable 30/07/2014 30,/07/2014

MedReview Standard [MR-5) Completed Electronic Mo Fee Applicable 30/07/2014 30/07/2014

MedReview Standard [MR-S) Declined by Pharmacist No Fee Applicable 30/07/2014  30,07/2014 E
MedReview Standard [MR-5] Dedined by Pharmacist Mo Fee Applicable 30/07/2014 30,07/2014

4. The MedReview Standard (MR-S) screen will appear. Click the various tabs to see the
Medication Review information that has been entered.

Medication Review View S
(MR-S) - Standard

Created 22-Aug-2014 09:11 AM Status | Pending

Fee Status | Review Mot Completed Yet Fee Rx N/A

Started 22-Aug-2014 09:11 AM Completed | N/A Duration | N/A View Signatures

Reviewed By | Preetha Reviewed With | Dukes, George (In Person)

Questions | Medical History | Non-Prescription Medications | General Comments PharmacistCommentsI

Has a doctor requested a medication review <Mot Answered>

Doctor Med Review Reason - Has multiple diseases <Mot Answered:=

Doctor Med Review Reason - Has one or more chronic diseases <Mot Answereds

Click Print to print the Medication Review, or View Signatures to view the pharmacist’s or
patient’s electronic signature.

Scanned Reviews with Manual Signatures
1. Bring up the patient card using the F3 Patient search.

2. Select Medication Review/Dialogues from the right navigation pane.
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3. Highlight the completed Medication Review and click F2 - View Details.

4. The MedReview Standard (MR-S) screen will appear. The Review tab displays information
entered on-screen during the Medication Review; the Documents tab displays the scanned
image of the signed Medication Review. Scanned paper Medication Reviews is also viewable
from Patient Documents.

Medication Review View - — - E P9

(MR-S) - Standard X Close
Created 30-Jul-2014 02:25 PM Status | Completed Electronic Fee Status  Claimed FeeRx 1087677
Review | Documents

Started 30-Jul-2014 02:25 PM Completed | 30-Jul-2014 02:26 PM Duration  1m Os € nature [ Print J

Reviewed By | Scott Belfer Reviewed With | Belfer, Scott (In Person)

Questions | Medical History | Non-Prescription Medications | Rxs From Other Pharmacies | General Comments I Pharmacist Comments

Have you received a MedsCheck review from another pharmacy in the last 12 months No

Medical Devices - BP Machine Yes

Medical Devices - Glucometer Yes

5. Click Print to print the Medication Review.
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Paper Medication Reviews

This section explains how to perform paper Medication Reviews. Paper Medication Reviews

must be completed on paper, signed, and scanned back into the system.

NOTE: The automatic prompts will not appear if the patient does not meet the criteria for a
Medication Review. However, based on other available information and your professional
judgement, you can determine whether the patient might benefit from a Medication Review
and then manually create a Medication Review.

Configuring the Medication Review Prompt

The system prompts for Medication Reviews when the option Prompt for Medication Review is
enabled under File > Configuration > Store > Rx > Prompting.

7
%’ Store Level Configuration Parameters

===

| generall Eatientl Drug I Dgctorl

Fix | EDB | édiudicationl Labelsl Hepor!sl §ecurit_l,l| lnterfacesl Drdgrl 5-.-’-‘«FI| ¥-To D0|

(e ctri (=)

1- Generall 2 - Pricing| 2- Prompting| 4 - Mursing Homel 5 - Background Rix FiIIingl B -Workflowl i- Eounselingl - EeFI:-c|

Prampt ta use Drug Subs [T Automatically use Drug Subs
Uze Drug Subs when Batching
Frompt If Doctor Refused Repeat \when Canceling Rx
Prompt for Camments when Canceling an Bx
[ Ahways require comment
[] Prompt for Comments when Inactivating an R
[ Always require cormment
[ Prompt for Patient Counzelling on new Rix
[] Prompt to Batch NH Rixs
Prompt when not digpensing ag drug's Pack Size
Frompt For Repeats ‘When Copying an A=
Prompt Ta Use Manual Price From Last Refil
[] Remove Manual Price far Batched Rxs
[] Prompt if Dactor Autharization Received for Marcotic Rxs
[ Check for High Intensity Drugs
Prompt if there iz not enough inventory to fill the Fx
[] Prevent Copying an Inactive Fix ta a New Number
[ Show local patient profile an fill
Frompt to Copy "Mistake" Fis toa Mew Number
[ Show thermal/dot matrix label config on autofil

[] Prompt to Print Script Image: for 1st Fill of an Unfilled Rx
[ Prompt for &4DL Plan Infarmation if S& number is NOT set

[ Prompt if 'wWas Undeliverable when Cancelling an Rx

Drrug Programs
[] Participate in the Rx Canada / Health Inform Program

[T Participate in the Pharmacy Access program
[] Use Station Mame Subdirectories For Pharmacy Access
Days Back: 365

[] Enable Rx Canada Program [RxGateway)

Services
[] Prompt ta Enral Patients in Refil Feminder or Auta Fefil Frogram
Prompt to Enrol HH Patients in Refill R eminder or &uto Refill Program
Prompt ta Enable R far Refil Reminder and Auto Refill Program

Enrol Patients for Pickup Motification Mo j
Enrol MH Patients for Pickup Motification No j

Prompt to copy workflow packaged info for cancel and refill Fixs
Prompt to copy to new number if refiling an Fx with no repeats
[ Prompt for Due Date on autofil batches

[ Prompt for T= comment on autofill batches

Save Route code from Rx as default walue if no default is st Ask ﬂ

Save Form code from Ry as default value if no default iz set Ask ﬂ

I Prompt for Medication Review I
|| Track Medication Heview Rejection Reason:
Allove Wewer Prompt’ For Medication R eview

Search o OK
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When the option ‘Prompt for Medication Review’ is enabled, the system screens each patient
for Medication Review eligibility every time an Rx is processed. If the patient is eligible, the user
is prompted and presented with a number of options as shown below.

' Select an Option = =

This patient may be eligible for the MedReview Standard (MR-5) program.

Erint Report Now

Enint Report Later

I have Qther Rxs to fill for this patient

Do not prompt me until the next time the patient comes in.

Do not prompt until ...

MNever Prompt for this patient

e Print Report Now: This will call up the Medication Review report so you can select the
items you would like to print on the report.

e Print Report Later: This places a record in the Medication Review queue allowing you to
print the Medication Review at a later date or time. See section ‘Completing Medication
Reviews ‘Saved for Later’ for more details.

e | have Other Rxs to fill for this patient: This will allow you to continue filling more Rxs
for the patient before printing the report.

e Do not prompt me until the next time the patient comes in: This will suppress
prompting for today. The next time the patient comes in to fill an Rx, you will be
prompted for the Medication Review.

e Do not prompt until: This will allow you to dismiss the prompt for a specified number of
days, or until a specified date, after which the prompt will appear.

o Never prompt for this patient: This will suppress any further prompts for this patient.
This option is only available if the configuration option of Allow ‘Never Prompt’ for
Medication Review is enabled.
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Creating a Paper Medication Review (Manual)

1. Bring up the patient card using the F3 Patient search.

2. Select Medication Review/Dialogs from the right navigation pane.

File Edit Patient Profile Reports Utilities MNH Central Fill Cards Session Help
F3 - Patient F5 - Drug F7 - Doctor I F9 - Workflow F11 - Drop-off " F12 - New Rx “ Alt-X - Start ]
Last Name Doe First Name Jane salutation Ms. j _ Save Patient
Profil
Address1 100 Main St Phone Numbers (1) (PS8 girthdate 01/01/1980 —
Description |Phone | All Rxs
Address 2 Age 34 years -
J J Cell (555) 555-5555 J Active Rus
City Vancouver | Prov BC - Gender Female - il il
No image available Active Rxs w/Passtimes
Postal M2M 2 Country Canada j language English j Refillable R
Hiakle 5
Email janedoe@email.com Family Doctor Liont Pricing Profil
rncing Frofile
Quick Code [¥eIght (Ltoas ] Detete ] Mot Disp./OTC Rxs
J
Comments (0) ODB hd - i
Topic |Comment J Rus Filled in Error
Plans (1) (F2) Cos] (£el) Suspended Rxs
| subPlan Code| Group ID | client ID |Expiy | -
1 RCMP 33040 33223 Perform FDB Analysis
View
Alternate Addresses
i = . Batches
Allergies (0) [F2] (Tng] (Del] ngeral] Family Nursing Home} Copaygl Commgmcatlons] Other ] [ (=
Charting
Krol\ Mursing Home j Admit Date Tnactive [ c .
ONSEN’
Ward j Discharge Date Credit Card
redit Cards
Cycle <Default> | Last TR Date - -
oCuUments
_ _ Bed Status
Medical Conditions (0) Ing Roam € u Medication Review/Dialogs (15) I
Diet Rx Counseling History

3. The Medication Review queue will appear. Click N — New Review/Dialog.

=% Patient - Helvey, Ricky <A = | B R

File Edit Patient Profile Reports Utilities NH  Central Fill Cards Session Help

F3 - Patient F5 - Drug F7 - Doctor F9 - Workflow F10 - Pickup “ F11 - Drop-off " F12 - New Rx H Alt-X - Start

Last Mame Helvey First Name Ricky Salutation j _ Save Patient
Profile
N - New Review/Dialog

All Rxs
Medication Reviews [0] =1 Active Rxs
Tupe Statug Fee Status Created ¥ | Completed || Active Rxs w/Passtimes
| ||| Refillable Ras

4. The Medication Review/Dialog screen will appear. Select a review type from the dropdown

menu and click Print Now. If you wish to add to the Med Review queue in order to print the
Medication Review later, click Save for Later.

=

o Medication Review/Dialog @J@

Type MedReview Standard (MR-S) j

| Print Mow I lgaveforlaterl [ X cancel l
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5. The Medication Review Rx Selection screen will appear. Rxs under the Pre-Selected tab are
selected by default; Rxs on the other tabs are not. Proceed through each tab and check the
Rxs you want included in the report.

e Select Do Not Profile Rxs if you want the report to include Rxs that have been filled
at your pharmacy only.

e Select Profile All Rxs (TRP) if you want to include all Rxs for the patient available on
the Pharmanet network in the report. Note that Rxs filled at your pharmacy may
appear twice on the report if this option is selected.

e Select Profile Other Store Rxs (TRS) if you want the report to include Rxs that have
been dispensed in your pharmacy and in other pharmacies.

Use the Include last [x] month(s) of Pharmanet Rxs to specify a date range.

o Medication Review Rx Selection (o0 o] | 0 e
Pre-Selected (2) | Other Rxs | Unfills | Not Dispensed | Discontinued |
Rt Num Drug Fill Date
1000002 Kanax 1mg 06-Aug-2014
1000001 Paxil 10mg 06-Aug-2014
Select all ] ’ Select None ]
Pharmanet Medications
@ Do Mot Profile Rxs
! Profile All Rxs (TRP) IIncIude last 1 % month(s) of Pharmanet Rxsl
_ Profile Other Store Rxs (TRS)

Drug lines to use in review

Drug line 1 Default j Drug line 2 Default j

7ok

When you are finished, click OK.
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6. The Medication Review Report form will appear. Check Print Best Possible Medication
History Worksheet if you want to generate this worksheet.

Select the appropriate print options and select the appropriate user from the Prepared by

field. Click Print.

=

o Medication Review Report ((MR-5) - Standard, 2014-Aug-22)

File

Options

Print store logo
[C] Print Last Fill Date
I Print Best Possible Medication Histary Worksheet |

Frepared by
Agaril

£

Extra Lines for Allergies and Conditions
Extra Lines for "Medications | Take"

Extra Lines for "Current Medications”

@y ¥ @ @H

Extra Lines for "Clinically Felevant Medications the Patientis no longer taking"

Printer Microsoft XPS Document Writer

Tray (Default tray)

j Copies

1

j [¥] collate  [7] Duplex

’Bestore Defaults] [ " Erint ]

’ Frenigny ]

’ X Close ]

7. Complete the Medication Review on the form. Sign the Medication Review Report and

have the patient do the same.
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Scanning Medication Review Reports

8. From the Alt-X Start screen, go to Utilities > Printed Document Scan/Import.

File Edit Reports [Utilities | Central Fill Cards Session

Help Version 10

F3 - Patient [

Last Rx Numbers

1000
9000
Modify R

Reprint R

Cancel Ry

Modify Specifi
Reprint Specifi
Counsel R

Drug Ordering
Merge

Unmerge

Adjust Current Wait Time
Check Interactions
Quick Price

Delivery Orders

View Mail/Messages

View Packager Batches

View Pending Metwork Queue
Labels

Script Reentry Mode

Credit Card Password Manager
Database Maintenance

Drug

Patient/Rx Import

Y }kﬂow " F11 - Drop-off " F12 - New Rx “ Alt-X - Start ]
3

Alt+=

Followups

0-1hrs  1-4 hrs 4+ hrs  Tomarrow  Trouble Total
0 0 0 0 0 4 R Counts
Mew Rxs 0
0 0 0 0 0 4 Repeat Rxs 0
3
Total Rxs 0

Printed Document Scan/Import

9. The Import Scanned Documents screen will appear. Place the report pages face down on
the scanner hopper. Check Scan both sides of paper if you are scanning pages with
information on both sides and your scanner supports dual side scanning. Click Start

Scanning.

7
Import Scanned Documents

B~

Scanner
Scanner
Mode

Resolution 100

FUJITSU fi-6130dj
Colour

IScan bath sides of paper [[] I

Document Processing
To Process 0

To Reconcile @

Wiew Scan History

[ Process and Reconcile ]
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10. When scanning is complete, the screen will indicate how many pages were scanned
successfully and how many will need to be manually reconciled. When you are finished,
click Process and Reconcile.

Impart Scanned Documents E 2

Scanner

Scanner  FUJITSU fi-6130Zdj #2

Maode Colour
Resolution 100 Scan both sides of paper [

Document Processing

To Process 0 I Process and Reconcile I

To Reconcile @

Wiew Scan History

11. The Document Scan Reconciliation screen will appear. Items ready to be processed will
appear in the Documents to be created section. Items that need to be reconciled will
appear in the Unprocessed Images section.

¢ Document Scan Reconciliation ®E|lo = P9

Documents to be created (1)
Scanned on Status Filed By Tyvpe Title Patient RxNum |Pages| Message -
11/07/2014 12:31:43 | Ready Ta File e

m

H@ |Zoom 500 % & _!,{| BB &E ‘j o | Unprocessed Images (0)| Current Document_
-lD Images (2) [Del) (A% [~
Scanned On{ Type #| Info Message -
(MR-5) - Standard = =
N - ; — f—— 12:31:43 | Patient Med Reviey 1
Fhone: (355) 555-5555  Fau: (656) 5666660 1231:45  Patient Med Reviey 2

BEST POSSIBLE MEDICATION HISTORY (EPMH - Patient Section

PATIENT

TR [EEL T e E
Jone Dee Doctus, Teat b
T08 Tandar | EAN Fom b0, =
10341957 F 1256789 PRI R
Teres Tendbans
AllergyCream wa

[ Pstivenit s mud takinvg e noewrescr wbun orrratural esiih arogucs althis ime.

COMMENTS

PATIENT ACKNOWLEDGEMENT
My phasmiadist hasexplained to me the surpose of amedication review sarvice. [ sgpeed that [oouid benafit from this publcly funced

sevvice, The review was conchucied ing Etl‘dl\?}gﬂ.i&lmy iwancy. Duin e acporntment my phamecet fuly emlsmed sy
m.“l‘l’l ﬂ“ﬁ’?g;tl':‘gmwﬂm ﬁ?%ﬁfmmmjﬂiﬂ%wkﬂl rllwrr.;rﬁr WH’DJ{V ATy CLITEN! -
Document Type Patient Med Review j
Z1-Aug-Z014
Deetes Prepuewed Petient (cr Represeriatve) Sigetue [— Patient
MName Jane Doe DOE 24/10/1950
Address 100 Main 5t
City, Prov Vancouver, BC
Med Review
11/07/2014 - (MR-S) - Standard (Printed Paper) j
Brightness Contrast Saturation
0 0 0 [ X Cancel] E " Next ]
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12. If all Rxs were scanned successfully and appear in the Documents to be created section,
click the Process Pending Documents button. Click Cancel to close the screen.

Billing a Medication Review

13. Once scanning is complete, the Fee For Service claim will automatically populate in the F12
screen. If necessary, perform a doctor search to locate the pharmacist to use as the
prescriber and ensure all of the other information entered on the F12 screen is correct.

14. Click F12 - Fill Rx. The claim will be transmitted to the appropriate party for payment.
Completing Medication Review ‘Saved for Later’
1. To call up Medication Reviews ‘saved for later’, do one of the following:

Patient Card

a) Bring up the patient card using the F3 Patient search and select Medication
Review/Dialogs from the right navigation pane.
b) The Medication Reviews queue appears with all the Med Review records that are pending

review.
File Edit Patient Profile Reports Utilities NH Cards Session Help
F3 - Patient F7 - Doct F9 - Workflow F11 - Drop-off F12 - New Rx Alt-X - Start
LastName  Dukes First Name George Salutation M X Cancel | | Patient
= ~ ¥ Profile
N - New Review/Dialeg P - Print/Reprint Al Rcs
F2 - View Details D - Pharmacist Declined R - Patient Refused Active R
Medication Reviews (8) (F2) s (0ey) | “IVE TS
Type | Status | Fee Status | Created ¥ |Completed | ~ | Active Rxs w/Passtimes
MedReview Standard [MR-S) Pending Review Not Completed Yet 15/08/2014 Refillable Ros

c) Select the Medication Review record you want to complete and click F - Call Up.

F9 - Workflow

a) Select F9 - Workflow from the Alt-X Start screen and select Medication Reviews from the
right navigation pane.

b) The Medication Review queue will appear. Select the Medication Review you want to
complete and click F - Call Up.

File Edit Utilities NH Workflow Cards Session Help
F3 - Patient F5 - Drug F7 - Doctor f F11 - Drop-off 1 N Alt-X - Start
. . . - Pri il I'a m u i Workflow Actions
Medication Reviews 5 birtmerrint [ el el
D - Pharmacist Declined R - Patient Refused  space - Mark Rxs Rx's To Do
Patient llype [Smus IFee Status |<reated |Completed » | RxsinProgress
Dukes, George MedReview Standard (MR-S) Pending Review Not Completed Yet 15/08/2014 Pending Adjudication (0)
Dukes, George MedReview Standard (MR-S} Pending Review Not Completed Yet 07/08/2014
Dukes, George MedReview Standard (MR-S) Completed Electronic  Pending Claim 07/08/2014 07/08/2014 Trouble (0)
Dukes, George MedReview Standard (MR-S) Completed Electronic  Pending Claim 07/08/2014 07/08/2014 Rx Counseling (2)
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2. Complete steps 4-14 of the Creating a Paper Medication Review section.

Sample Paper Medication Review Report

(MR-S) - Standard
Kroll Computer Systems Pharmacy, Suite 201- 1502 West S0th Avenue South Vancouver Mainland, Vancouwer BC VIV 0VD
Phone: (555) 555-5555 Fax: (666) 666-6666

BEST POSSIBLE MEDICATION HISTORY (BPMH) - Patient Section

PATIENT
FlrstName LastName Family PhysicianName
Jane Doe Doctor, Test
[aTal:} Gender | PHN Family PhysicianPhane Family PhysicianFax
19-Jul-1957 F 123456789 nmpmnam
Affergies Condibons
AllergyCream N/A

|:| Patient is nottaking any non-prescription or natural health products atthis time.

MEDICATIONS | TAKE - Frescription, non-prescription, natural heaith products -

WHAT | TAKE WHY | TAKE IT HOW | TAKE IT SPECIAL INSTRUCTIONS
Name strengin & farm of medlcaton Disaasa conaion ar For avampla whan i ke & {1 sonlicaniz)
35 ol O the prescristion or Symplams | addresses ke Wit o
medication package labal warings, i
1 | CAP Teva-Amoxicilin 500mg AS DIRECTED
2 | TAB222375/8mg AS DIRECTED

EI/F'atient is nottaking any non-prescription or natural health products atthis time.

PATIENT ACKMOWLEDGEMENT

My pharmacist has explained to me the purpose of a medication review service. Iagreed thatI could benefit fromthis publicly funded
service. The review was conducted in a place that respected rmy privacy. During the appointment my pharmacist fully explained any
medication changes or concerns to me. Atthe end of the medication review appointment, rmy pharmacist gave me a list of my current
medications. The list includesany changesresulting fromthe medication review service provided.

22-Aug-2014

Date Prepared Patient (or Representative) Signature Crystal(06363)

e This printout only includes Rx items that were selected on the Medication Review Rx
Selection screen.

e Provide this printout to the patient.
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A

(MR-S) - Standard
Eroll Computer Systems Pharmacy ., Suite 201- 1502 West Sith Awerwe South Vancouver Mainland, Vancouver BC VOV 0WD

BEST POSSIELE MEDICATION HISTORY (BPMH)

Phone: (555) 555-5555

CLINICAL NEED FOR SERVICE
Has a prescriber requested a medication review: I:‘ No

Patient:
l:l Hasmultiplediseases

D Hss oneormore chronicdiseases

D Hasadrug therapyproblem

D Hasmultipleprescribers

CURRENT MEDICATIONS

|:| 'es, Prescriber:

Fax: (666) 666-6666

I:l Hasbeenrecenthdischargedfromhaospital

l:‘ Tskesmedication|{sthatrequirdaborstorymenitoring

- Health Care Professionals Section

D Hasamedicationregimentincludingoneofmorenaturalhealthproducts

I:‘ Hassmedicationregimentincludingonecimorenonpresoiptionmedications

HAME OF DRUG PRESCRIBER MAME & | VERIFIED ACTION NOTES
& STRENGTH PROFESSION Continue a5 par { = FHARMANET | For seample: tanniicabiel
Far axample: o2 = FATIENT Drug Thamay: Franiem ol )
BhpEiclan D REN sifmemnt than Fhammakiel w0 L gl
natumsaih, shamscist patient or3 = EATIENT fat bn Fhomabizti
1 |CAP Teva-amoxicillin Dr.Smith, John H 2 - Palimnl DrugTherapyProblem
500mg DoctotPhysician) (different than Pharmahist) Plan
2 |TAB 222 375/8mg Dr.Smith, John H 2 - Paliet
DoctatPhysician) (dfferenl tan Frermabiel)
CLINICALLY RELEVANT MEDICATIONS THE PATIENT 1S NO LONGER TAKING
HAME & STRENGTH WHY IT WAS TAKEN MOST RECENT WHO STOPPED IT COMMENTS
OF DRUG REGIMEN Hame of prmscriber shamacist | Reasanfor siosglng sfechiensss
patint o Diner ather mlavant intamatan
LOCATION OF THE ASSESSMENT
Name Addresz

KrollComputersystemsPharmacy

Suft= 201-1502 West 50th Avenus

attantion Sources of Inrmztion I ils document Include (Dut are not limRed b} Pharmaiet, local prammacy data and Me patlent. The patlent ks responsinie

Hgalth Cars for M2 EcCUrECY and cOMpKEeNsEs Of e 0aE ey providsd When MIS OTUTIEN! WaE DIEgEred and WOr alMshg Me DREMMECE! of any CEnge 0

Frofesshonals: Fiese medications. The prammacts: s responskile ’br Irormation In s document st changed as @ resull of providing a medication neview
E

FogeZof 2 Freperecon: 22-Aug-2014 Freparedby: Crystal{06363)

e The CURRENT MEDICATIONS section of this report includes Rx items that were marked
selected on the Medication Review Rx Selection screen.

e The CLINICALLY RELEVANT MEDICATIONS THE PATIENT IS NO LONGER TAKING section
includes inactive Rxs.

e This printout is for pharmacy use only and should not be provided to the patient.
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BESTPOSSIBLE MEDICATION HISTORY WORKSHEET

Patient: Jane Doe Pharmanet Printout: Pharmacist Submitting Request:  April
PHN: 123456789 Date/Time:  22-Aug-2014,12:56
Pharmacy #: KC9

Kroll Computer Systems Pharmacy ) ) Pharmacist:

Si Provider:
Phone:(604) 383-1010 Fax: (604) 383-0001 SrviceFrovicer
Date:

Date of Birth: 19-Juk1957 Patient Gender: M Patient Phone Number: (555) 555-5555
Family Physician:  Smith, JohnH Family Physician Phone Number: (111)111-1111

The following is a PharmaMet extract of the most recent medication and claims record for the above patient
inthe province of British Columbia over the last 6 month(s)(604) 266-0168.

Donot; nethepatienti rentlytakingthesemedicati inthesed Pleaserevi T p

Please note thatchanges MAY have been made to the patient's provincial medication records since this report was printed. In addition, it MAY contain
dizcontinued medications and does NOT contain updated instructions the patient may have received from their physician or such tems as non-prescription
drugs, samples, investigational or clinical trial drugs, complementary and alternative therapies, natural health products, selected prescriptions obtained through
provincial programe (e.g., antiretrovirale), or prescriptions obtained from outside the province orover the Internet.

Clinical Information (as per PharmaNet)
Adverse reaction(s):

FOR. INTERMNAL PHARMACY USE ONLY Page 3of 3

e This printout details Rxs from Pharmanet only. If you are printing all Rxs from
Pharmanet, this printout will also include Rxs that are on the patient’s local profile.

Viewing a Completed Medication Review
1. Bring up the patient card using the F3 Patient search.
2. Select Medication Review/Dialogs from the right navigation pane.

3. Highlight the completed Medication Review and click F2 - View Details.
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4. The (MR-S) - Standard screen will display the scanned image of the completed Medication
Review. Scanned Medication Reviews are also viewable from Patient Documents.

Medication Review View - — - - Bl =
(MR-S) - Standard
Created 30-Jul-2014 02:34 PM Status  Completed Paper Fee Status Claimed FeeRx 1087678
2014-07-30 2:39 PM

B & @ oomos3 %@ @[O0 DG 8EnE

(MR-S) - Standard
Kroll Computer Systerms Pharmacy, Suite 201-1502 West S0th Avenue South Yancouver Mainland, Vancouwer BC VOV 0W0
Phone: (555) 555-5555 Fau: (666) 666-6666

BEST POSSIBLE MEDICATION HISTORY (BPMH) - Patient Section

PATIENT
Firsthiame LastiName Family Physicianame
Jane Doe Doctor. Test
DoB Gender | AN Family Physician Phone Family Physiclantax
19-Jul-1957 F 123456789 -1
Allergies Conditions
AllergyCream NfA

|:| Patient is nottaking any non-prescription or natural health products atthis time.

COMMENTS
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Declined and Refused Medication Reviews

This section explains the process for recording Medication Reviews that have been declined by
the pharmacist or refused by the patient.

NOTE: The medication review records that are declined by the pharmacist or patient refused
can also be noted from the Medication Review queue on the F9-Workflow screen.

Pharmacist Declined
1. Bring up the patient card using the F3 Patient search.
2. Select Medication Review/Dialogs from the right navigation pane.

3. Select the appropriate Medication Review and click D — Pharmacist Declined.

File Edit Patient Profile Reports Utilities Central Fill Cards Session Help

F3 - Patient F m F7 - tor F9 - Worlflow F11 - Drop-off F12 - New Rx | Alt-X - Start
Last Name Test First Name Pat Salutation lJ oK T X scan |
N - New Review/Dialog P - Print/Reprint F - Call up
F2- View Details | D - Pharmacist Declined | R - Patient Refused
Medication Reviews [2) [FZ)[Ins] (Del)
Type |Sta|us |Fee Status I Created ¥ ICompleted I -
MedReview Standard [MR-5) Pending Review Not Completed Yet 30/07/2014
MedReview Standard (MR-5] Pending Review Not Completed Yet 30/07/2014

4. Select the appropriate option from the Decline/Refuse prompt.

o Select an Option l@”él

Decline/Refuse - MedReview Standard (MR-5).

’ Do not prompt until the next time the patient comes in. ]

’ Do not prompt until ... ]

I Mever Prompt for this patient l

I Cancel l

e [f you select Do not prompt until the next time the patient comes in, no further action
is required until the next time the patient visits the pharmacy.
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e [f you select Do not prompt until... you will be prompted to specify the next time you
want to be prompted for the patient’s Medication Review. Complete the form and click

OK.

e If you select Never Prompt for this patient you will not receive any additional

Medication Review prompts for the patient.

Patient Refused

1. Bring up the patient card using the F3 Patient search.

2. Select Medication Review/Dialogs from the right navigation pane.

3. Select the appropriate Medication Review and click R — Patient Refused.

Eile Edit Patient Profile Reports LUtilities Central Fill Cards Session Help

F3 - Patient F9 - Worlflow F11 - Drop-off F12 - New Rx Alt-X - Start
Last Name Test First Name Pat Salutation - OK X scan |
N - New Review/Dialog P - Print/Reprint F - Call up
F2- View Details D - Pharmacist Declined | R - Patient Refused |
Medication Reviews [2] [[F2][Ins) [Del]
Type | Status | Fee Status 1Crea!ed i ICompIeted -
MedReview Standard [MR-5) Pending Review Not Completed Yet 30/07/2014
MedReview Standard [MR-5) Pending Review Mot Completed Yet 30/07,/2014

4. Select the appropriate option from the Decline/Refuse prompt.

i o Select an Option |EJ&J

Decline/Refuse - MedReview Standard (MR-5).

l Da not prompt until the next time the patient comes in. I

I Do not prompt until ... I

I Mever Prompt for this patient I

I Cancel I

e If you select Do not prompt until the next time the patient comes in you will be
prompted to specify if the review was declined by the Patient or Someone Else.

o If you select Someone Else, the Medication Review/Dialog Refusal form will
appear. Click the lookup button next to the Select agent field to search for the
patient who refused the review. Select a relationship from the Relationship to

patient menu and click OK.
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| ¢ Medication Review/Dialog Refusal | & |&J
Refused By  (O) Patient @ Someone Else
Select agent Doe,Jane j
Last name Doe
Eirst name Jane
Relationship to patient@ vl
I V' ok I ’ X Cancel]

o No further action is required until the next time the patient visits the pharmacy.

e [f you select Do not prompt until... you will be prompted to specify the next time you
want to be prompted for the patient’s Medication Review. Complete the form and click

OK.

e If you select Never Prompt for this patient you will not receive any additional
Medication Review prompts for the patient.

NOTE: Medication Review records that have been refused or declined cannot be deleted
from the Medication Reviews queue.

Medication Review Statuses

This section explains the statuses that appear in the Medication Review queue at various
stages throughout the Medication Review process.

Statuses

File Edit Patient Profile Reports Utilities NH Central Fill Cards Session Help

MedReview Standard [MR-5)
MedReview Standard (MR-5}

Declined by Pharmacist
Refused by Patient

F3 - Patient J F9 - Workflow F11 - Drop-off F12 - New Rx Alt-X - Start
Last Name Doe First Name Jane Salutation Ms. j | oK x T Patient
: ~ ¥ Profile
N - New Review/Dialeg P - Print/Reprint F - Callup Al Re
F2 - View Details D - Pharmacist Declined R - Patient Refused
Medication Reviews (5) (72 [Ins) (Bal) Active Rxs
Type Status |Fee Status |Crested * |Completed | ~ || Active Rus w/Passtimes
MedReview Standard [MR-5] Pending Review Not Completed Yet 19/08/2014 Refillable Rxe
MedReview 5tandard (MR-5) Printed Paper Review Not Completed Yet 310772014 . »
MedReview Standard [MR-5) Completed Electronic Pending Claim 06/08/2014 06/08/2014 - Pricing Profile

Mo Fee Applicable
Mo Fee Applicable

11/07/2014 1107/2014
19/08/2014 19/08/2014

Not Disp./OTC Rus
Rus Filled in Error

Pending

Reviews that have been initiated but have not yet been completed.

Printed Paper

Reviews that have been printed but have not yet been billed.
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Completed

Reviews that have been printed and billed.

Declined by Pharmacist

Reviews that have been declined by the pharmacist.

Refused by Patient

Reviews that have been refused by the patient.

Fee Statuses

F3 - Patient

Last Name Doe First Name Jane

N - New Review/Dialog P - Print/Reprint
F2- View Details D - Pharmacist Declined
Medication Reviews [3)

Type ISlatus

File Edit Patient Profile R__epurls Utilities NH -(errln_)IFill Cards Session Help

Fee Status

Cieated ¥ | Comgleted |

MedReview Standard [MR-5)
MedReview Standard [MR-5)
MedReview Standard [MR-5)

Pending
Refused by Patient
Completed Electronic

Review Not Completed Vet
No Fee Applicable

Pending Claim

19,08/2014
19/08/2014 19/08/2014
06/08/2014 06,/08/2014

F9 - Workflow F11 - Drop-off F12 - New Rx Alt-X - Start
Salutation Ms.  +| oK X Cancel
F - Call up
R - Patient Refused
(F2](Ins) (0el)

Patient
Profile
All Rxs
Active Rxs
Active Rxs w/Passtimes
Refillable Rxs
Pricing Profile

Review Not Completed Yet

Reviews that have been initiated but have not yet been completed.

No Fee Applicable

Reviews with no associated fees (usually declined or refused reviews).

Pending Claim

Electronic reviews: Completed reviews with a Status of Completed.
Paper reviews: Reviews that have been printed and the option Require Document scan to
complete Paper Med Review is off, and reports that have been printed and scanned back into

the system if this option is enabled.
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